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Declaration of Conformity

(according to ISO/IEC Guide 22 and EN 45014)

We,

Anacomp® Incorporated
12365 Crosthwaite Circle
Poway, CA 92064, USA

declare that the following product

DatagraphiX ImageMouse Plus Digital Retrieval System

to which this declaration relates, is in conformity with the applicable EC Directives, harmonized 
standards, and other normative requirements.

Low Voltage Directive 73/23/EEC of 19 February 1973 as Amended by 93/68/EEC

IEC 60950 2nd edition, 1991 + A1, 1992 + A2, 1993 + A3, 1995 +A4, 1996

EMC Directive 89/336/EEC

EMC: EN50082-1 (1997) incorporating the following:
EN55022 (1994) / CISPR-22 (1993) Class �A�
EN61000-3-3 (1995) Flicker
EN61000-3-2 (1995) Harmonics

EN 55024: (1998) incorporating the following:
EN61000-4-2 (1995) Electrostatic Discharge (±8 kV Air/± 4kV Contact Discharge)
EN61000-4-3 (1995) RF Radiated Fields (3 V/m, 80-1000 MHz, 80% AM @ 1kHz)
EN61000-4-4 (1995) Electrical Fast Transients/Burst (±1kV AC line; ±0.5kV I/O lines >3m)
EN61000-4-5 (1995) Lightning Surge (±2kV Common Mode /±1kV Differential Mode)
EN61000-4-6 (1996) RF Common Mode (150kHz-80MHz, 3Vrms, 80% AM 1kHz)
EN61000-4-11 (1994) Voltage Dips/Short Interruptions (Reductions: 30% for 10msec, 60% for 

100msec, and >95% for 5 secs.)

This product is intended to be supplied by a listed power supply rated at 5V DC, max. 3A.

Technical Support Tel:  1 (800) 920-SERV or 1 (800) 920-7378

European Contact:

Frank Roche
V.P. Technical Services International
Rosa, Mulberry Business Park,
Fishponds Road,
Workingham, Berkshire RG41 2GY

Tel: 44(0)1189776074
Tel: 44(0)1189773890                                                                         1115651-101, Rev. A



FCC Statement

This device complies with part 15 of the FCC rules. Operation is subject to the following two 
conditions:

(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including interference that may cause 

undesired operation.

UL Statement

The equipment is intended to be supplied by a Listed external LPS power supply.



Table of Contents

List of Figures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . iii

Chapter 1.  Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
What ImageMouse Plus Does . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
Who Uses ImageMouse Plus. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
How To Use This Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Manual Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

Keyboard and Mouse Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Text Attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3

Chapter 2.  Installation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
Software Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
Hardware Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6

Chapter 3.  Operation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1
ImageMouse Plus Depiction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1

Startup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Fast-Search Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4

Search Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
Image Intensity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-5
Image Focus  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6
Reduction Ratio. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6
Image Size. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6
Locating a Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6

Cut Microfiche or Microfilm . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6
Roll Film  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7

Image Rotation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
Full-Resolution Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8

Maximum View  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9
Freeze and Live. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10
Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-10
Invert and Normal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11
Printing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-11
Saving an Image File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-12
Viewing an Image File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13

Power-Saving Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
i



DatagraphiX ImageMouse Plus User�s Guide
Appendix A.  Controls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
Menu Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1

File Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
Image Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2
Help Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2

Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2
ImageMouse Plus Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-3
ImageMouse Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-4
ImageMouse Plus Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-4
Hot Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-5

Appendix B.  Frequently Asked Questions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-1
How can I view an image that is in a file? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-1
How long a cable can I use to connect my mouse?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-1
What other devices can I connect on the same USB hub? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-1
How can a quality image be obtained? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-1
How can a data file be associated with a program? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-1
How can I save exposure settings? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-4
What do I check or do if the mouse freezes? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-4
How can I better focus my prints? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-5
How do I copy a microfiche image to another program? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-6
How do I insert (or attach) an image file into another program? . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-6
How do I work with an Image using MS Paint and Kodak Imaging . . . . . . . . . . . . . . . . . . . . . . . . . B-6
How do I enable the USB port in the BIOS? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-9
How do I resolve conflicting IRQs? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-10

Appendix C.  Troubleshooting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-1
The Device Manager page lists no USB devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-2
The Device Manager page lists the USB Host Controller but no USB Root Hub . . . . . . . . . . . . . . . C-2
The Device Manager page detects no ImageMouse, but, under the Other Device line, 

                                                              an unknown USB Device line with a question mark exists  . . . . C-2
The Device Manager page detects the USB Root Hub and USB Host controller but not 

                                                                                                                       the ImageMouse . . . . . . . . . C-3
The USB connection locks up while operating ImageMouse Plus. . . . . . . . . . . . . . . . . . . . . . . . . . . C-3
The Device Manager page detects the USB Host Controller and the USB Root Hub, but 

                                                            ImageMouse appears under Other Devices as USB Device . . . . . C-3
Future Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-8
ii



List of Figures

Figure 2-1.  Loading the Setup Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2
Figure 2-2.  Operating System Detected Message Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2
Figure 2-3.  ImageMouse Welcome Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3
Figure 2-4.  Software License Agreement Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3
Figure 2-5.  User Information Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-4
Figure 2-6.  Choose Destination Location Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-5
Figure 2-7.  ImageMouse Installation-Progress Window (partial view)  . . . . . . . . . . . . . . . . . .  2-5
Figure 2-8.  Setup Complete Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-6
Figure 2-9.  ImageMouse Plus Connector-Receptacle Depiction. . . . . . . . . . . . . . . . . . . . . . . .  2-7

Figure 3-1.  ImageMouse Plus Depiction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-1
Figure 3-2.  Open Upper Platen Glass of the ImageMouse Plus  . . . . . . . . . . . . . . . . . . . . . . . .  3-2
Figure 3-3.  Loading a Roll of Film into the ImageMouse Plus . . . . . . . . . . . . . . . . . . . . . . . . .  3-3
Figure 3-4.  Film-Path Depiction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-3
Figure 3-5.  Example ImageMouse Plus Display After Initialization (Fast Search, Full Page).  3-4
Figure 3-6.  Hand on the Film-Carrier Handle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-7
Figure 3-7.  ImageMouse Plus Control Panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-7
Figure 3-8.  ImageMouse Rotation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-8
Figure 3-9.  Full-Resolution Mode (with the image frozen). . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-9
Figure 3-10.  Maximum Image-View Area  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-10
Figure 3-11.  Inverted Image  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-11
Figure 3-12.  Print Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-12
Figure 3-13.  Save Image File Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-13
Figure 3-14.  Open Image File Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-14
Figure 3-15.  ImageMouse Warning Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-15

Figure A-1.  ImageMouse Plus Control Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A-4

Figure B-1   Folder Options Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-2
Figure B-2.  Edit File Type Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-3
Figure B-3.  Editing Action For Type Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-3
Figure B-4.  Open With Dialog Box. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-4
Figure B-5.  Cropping in Paint . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-7
Figure B-6.  Copying the Cropped Image. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-7
Figure B-7.  Flip, Rotate, Stretch, and Skew the Image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-8
iii



DatagraphiX ImageMouse Plus User�s Guide
Figure B-8.  Annotation Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-9
Figure B-9.  Partial View of the Back of a PC with USB Ports . . . . . . . . . . . . . . . . . . . . . . . . . B-9
Figure B-10.  System Properties Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-11
Figure B-11.  Computer Properties Dialog Box, View Resources Page  . . . . . . . . . . . . . . . . . B-11
Figure B-12.  Computer Properties Dialog Box, Reserve Resources Page  . . . . . . . . . . . . . . . B-12
Figure B-13.  Edit Resource Setting Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . B-12

Figure C-1.  System Properties Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-1
Figure C-2.  System Properties Dialog Box Device Manager (Other Devices) . . . . . . . . . . . . . C-4
Figure C-3.  USB Device Properties Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-4
Figure C-4.  Update Device Driver Wizard Box (Driver Search)  . . . . . . . . . . . . . . . . . . . . . . . C-5
Figure C-5.  Update Device Driver Wizard Box (Display Drivers) . . . . . . . . . . . . . . . . . . . . . . C-5
Figure C-6.  Update Device Driver Wizard Box (Find Driver) . . . . . . . . . . . . . . . . . . . . . . . . . C-6
Figure C-7.  Install From Disk Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-6
Figure C-8.  Open Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C-7
Figure C-9.  Update Device Driver Wizard Box (Select Driver) . . . . . . . . . . . . . . . . . . . . . . . . C-7
iv



Chapter 1

Introduction
This manual describes the DatagraphiX® ImageMouse Plus� Digital Retrieval System, which 
Anacomp®, Inc. developed. It enables you to digitize and display a roll-film image on your 
PC�s monitor for further disposition.

What ImageMouse Plus Does
The ImageMouse Plus system enables you to:

� Digitally capture an image from either a:

� 42X or 48X microfiche or jacket
� 24X or 28X microfiche or jacket
� Original negative or positive film
� Diazo or vesicular duplicate film
� Roll film (ImageMouse Plus only)

� Display that image on your PC�s monitor

� Enlarge, mirror, rotate, crop, or reverse the polarity (negative, positive) of the image

� Save the image on your hard disk in either a JPEG, TIFF, BMP, or CMP graphics format

After you save the image as a graphic file on the hard disk, use the Windows� Paint program or 
another graphic utility program to further manipulate the image, such as enlarging, mirroring, 
cropping, and rotating.

� Output the finished image either to a printer, as an e-mail attachment, or by way of a FAX

Who Uses ImageMouse Plus
ImageMouse Plus users have access to either microfiche, cut microfilm, or roll film whose 
content they want to selectively either view, print, save as a graphics file, or send to a second 
party by way of e-mail or a FAX.
1-1
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How To Use This Manual
You can read the contents of this manual chapter-by-chapter for information about:

� Installation
� Operation
� Frequently Asked Questions
� Troubleshooting

Manual Conventions
This manual does not contain basic computer usage and general navigation procedures for 
applications running under Microsoft ® Windows� (such as opening menus, choosing 
commands, mapping drives, and so on). Refer to Windows documentation for these basic 
computer techniques.

Keyboard and Mouse Actions
The following conventions are used throughout this manual for specifying keyboard and mouse 
actions:

Described Action Means

Type ENTER. Type the word, ENTER, at the keyboard by holding down the Shift 
key, pressing keys E, N, T, E, and R, one after the other, then 
releasing the Shift key.

Press Enter. Press and release the key labeled Enter.

Click Item Place the mouse pointer on an Item and click the left mouse button.

Right-click Item Place the mouse pointer on an Item and click the right mouse button.

Double-click Item Place the mouse pointer on an Item and click the left mouse button 
twice, with a delay between clicks that is short enough so the clicks 
are not interpreted as two separate clicks.

Drag Here to There Place the mouse pointer on the Here item, hold down the left mouse 
button, slide the mouse until the mouse pointer is on the There item, 
and release the button.

Press Key1+Key2 Hold down Key1 while you press and release Key2.

Click Key+Item Hold down a Key while you click an Item.
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Chapter 1:  Introduction
Text Attributes
Specific attributes are applied throughout this manual to clarify the meaning of the text, as 
shown:

Attribute Means

Bold Labels of items that you act upon, for example: From the File menu, click 
Print.

Italics Labels of items in windows and dialog boxes, for example: In the 
Directory field, either type c:\imagemouse, or click Browse to 
specify a destination directory.

Courier
Font

Messages displayed and text you type, for example: When the 
prompt, Enter the path, appears, type 
c:\imagemouse.

Italicized
Courier
Font

Generic place-holder name that you replace with the actual text, for 
example: Type x:\imagemouse, where x is either drive c or d.
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Chapter 2

Installation
Before installing the DatagraphiX ImageMouse system, ensure that you possess a PC equipped, 
at a minimum, with:

� One Pentium-class CPU at 200 MHz (recommended: 400 MHz)
� 32 MB of RAM (recommended: 64 MB)
� 4 MB of video RAM (recommended 16 MB)
� One USB port (PCI-to-USB controller with Intel chipset recommended)
� One CD-ROM drive
� A keyboard and a PC mouse
� A 17-inch SVGA monitor
� A Windows-compatible 600-dpi (or higher) printer
� Either the Windows 98 Second Edition, NT Workstation 4.0, or 2000 operating system

and ImageMouse-specific components:

� One DatagraphiX microfiche tablet
� Either one 24X or 42X/48X DatagraphiX blue overlay grid
� One DatagraphiX image mouse
� One AC power cable
� One 5 VDC power adapter
� One USB cable
� One DatagraphiX ImageMouse Installation CD-ROM

Software Installation
To install the ImageMouse program on your PC:

1. Ensure that the ImageMouse is disconnected from the PC.

2. Turn on the PC.

3. When the Windows Desktop appears, insert the DatagraphiX ImageMouse Installation 
Software CD-ROM into the CD-ROM drive.

The setup wizard loads. See Figure 2-1 on page 2-2.
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Figure 2-1.  Loading the Setup Wizard

Figure 2-1.  Loading the Setup Wizard

The setup wizard automatically detects the version of Windows that is installed on your PC 
and displays a message to that effect�for example:  It found version 98 Second Edition. 
See Figure 2-2.

Figure 2-2.  Operating System Detected Message Box

Figure 2-2.  Operating System Detected Message Box

4. When the Welcome dialog box appears, click Next. See Figure 2-3 on page 2-3.

Note: If the Welcome dialog box does not appear, invoke the Installation procedure 
manually by clicking (or, if necessary, double-clicking) the setup.exe item in 
the root folder of the CD-ROM.
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Figure 2-3.  ImageMouse Welcome Dialog Box

Figure 2-3.  ImageMouse Welcome Dialog Box

5. When the Software License Agreement dialog box appears, read the Agreement and click 
Yes. See Figure 2-4.

Figure 2-4.  Software License Agreement Dialog Box

Figure 2-4.  Software License Agreement  Dialog Box
2-3



DatagraphiX ImageMouse Plus User�s Guide
Note: If you do not accept the conditions of the Agreement, click No, in which case, the 
installation procedure stops.

6. When the User Information dialog box appears, type into their respective fields:

� Your name
� Your company name
� The serial number of the DatagraphiX ImageMouse (located on the under side of the 

ImageMouse)

and click Next. See Figure 2-5.
Figure 2-5.  User Information Dialog Box

Figure 2-5.  User Information Dialog Box

7. When the Choose Destination Location dialog box appears, accept the default Destination 
Folder and click Next. See Figure 2-6 on page 2-5.
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Figure 2-6.  Choose Destination Location Dialog Box

Figure 2-6.  Choose Destination Location Dialog Box

8. The ImageMouse Installation-Progress window displays the percentage progress of the 
installation. See Figure 2-7.

Figure 2-7.  ImageMouse Installation-Progress Window (partial view)

Figure 2-7.  ImageMouse Installation-Progress Window (partial view)
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9. When the ImageMouse program finishes installing, the Setup Complete dialog box 
appears. Select the Yes, Iwant to restart my computer now radio button. See Figure 2-8.

Figure 2-8.  Setup Complete Dialog Box

Figure 2-8.  Setup Complete Dialog Box

10. Click Finish.

After your PC restarts, the ImageMouse DX icon,  ,  appears on the the 
Windows� Desktop.

Hardware Installation
To install the ImageMouse Plus hardware, connect the ImageMouse Plus assembly�s three 
cables, which are the:

� ImageMouse cable
� USB cable
� AC power cord

Note: When replacing the fuse, use a fast-acting 2.5 A (5 X 20mm) fuse (DatagraphiX part 
number 6533208-007)

To do so, perform the steps on the following page while referring to Figure 2-9 on page 2-7.
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Figure 2-9.  ImageMouse Plus Connector-Receptacle Depiction

Figure 2-9.  ImageMouse Plus Connector-Receptacle Depiction

1. Plug the ImageMouse cable�s DIN connector into its receptacle at the back of the 
ImageMouse tablet.

2. Plug the appropriate end of the USB cable into a USB receptacle at the back of your PC.

3. Plug the other end of the USB cable into its receptacle at the back of the ImageMouse Plus 
unit.

4. Plug the male end of the AC power cord into the 117 VAC power supply.

5. Plug the female end of the AC power cord into the AC receptacle at the back of the 
ImageMouse Plus unit.

6. Turn on the ImageMouse Plus unit�s power switch. At this point, the ImageMouse driver 
file normally loads automatically. In case it does not, a dialog box appears that prompts 
you to insert the Windows 98 CD-ROM into the CD-ROM drive for retrieval of this driver 
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file. Should this occur:

� Do not insert the Windows 98 CD-ROM into the CD-ROM drive. Instead, click OK.
� Browse to and highlight the file:

C:\Program Files\Datagraphix ImageMouse\ImageMouse\anacomp.inf

� Click OK. The ImageMouse driver file loads.

Note: To test the lamp, which is off when ImageMouse is not operating, momentarily press 
the lamp-test button. See Figure 2-9 on page 2-7.
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Operation
The ImageMouse Plus operates in one of two modes and, after a period of inactivity, 
automatically revert to a third standby mode:

1. Fast-Search mode (default)
2. Full-Resolution mode
3. Power-Saving mode

ImageMouse Plus Depiction
Figure 3-1 depicts the ImageMouse Plus.
Figure 3-1.  ImageMouse Plus Depiction

Figure 3-1.  ImageMouse Plus Depiction

ImageMouse

Film Carrier Handle

Control Panel

Manual Rotation Knob Manual Rotation Knob

Film-Reel Spindle Film-Reel Spindle

Idler Roller Idler Roller

Platen Glass
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Startup
To start operation of the ImageMouse Plus:

1. Ensure that the ImageMouse Plus software and hardware are installed according to the 
instructions contained in Chapter 2.

2. As appropriate, load the cut microfiche/microfilm or roll film in one of the two following 
methods�ready for viewing:

Method 1:  Cut Microfiche/Microfilm

� With the film-carrier handle, pull the film carrier out to open the upper platen glass. See 
Figure 3-2.

Figure 3-2.  Open Upper Platen Glass of the ImageMouse Plus

Figure 3-2.  Open Upper Platen Glass of the ImageMouse Plus

� Place a cut microfiche or microfilm between the upper and lower platen glasses with 
the title toward the back of the glass and centered between its left and right edges.

� With the film-carrier handle, push the film carrier in to reclose the upper platen glass.
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Method 2:  Roll-Film

� With the film-carrier handle, pull the film carrier out to open the upper platen glass. See 
Figure 3-3 on page 3-3.

Figure 3-3.  Loading a Roll of Film into the ImageMouse Plus

Figure 3-3.  Loading a Roll of Film into the ImageMouse Plus

� Place a roll of film on either of the two film-reel spindles so that the film pays out from 
the top, pull the film through the space between the glass platens, and thread the film 
end onto an empty reel on the other spindle so that the reel takes in the film over its top. 
See Figure 3-4.

Note: After the roll of film is in place, if the image is inverted on the monitor, remove the 
two reels of film and exchange their places on the film-reel spindles.

Figure 3-4.  Film-Path Depiction

Figure 3-4.  Film-Path Depiction

� With the film-carrier handle, push the film carrier in to reclose the upper platen glass.

3. On the Windows� Desktop, click (or, if necessary, double click) the ImageMouse DX 

icon,   .

The ImageMouse Plus main window appears on the PC monitor and displays a picture of the 
ImageMouse unit while ImageMouse Plus initializes. Then, the USB activity indicator

 blinks, and ImageMouse Plus enters Fast-Search mode and displays the portion of the 
image that is beneath the ImageMouse�s lens. See Figure 3-5 on page 3-4.

Film-Reel Spindles
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Figure 3-5.  Example ImageMouse Plus Display After Initialization (Fast Search, Full Page).

Figure 3-5.  Example ImageMouse Plus Display After Initialization (Fast Search, Full Page)

Fast-Search Mode
Upon first operating ImageMouse Plus, the default mode is Fast-Search, which refreshes 
images faster than does the Full-Resolution mode.

Use this mode when moving the ImageMouse Plus to search for a particular page or for 
adjusting exposure, background, and image focusing.

Note: While in the Full-Resolution mode, you can reinvoke the Fast-Search mode by pressing 
the Backspace key. You can toggle between these two modes�when in the Full-
Resolution mode, press the Backspace key for the Fast-Search mode, or, when in the 
Fast-Search mode, press the Enter key for the Full-Resolution mode.

When in Freeze, press the Esc key for Live, or, when in Live, press the Spacebar for Freeze.

Search Options
Fast-Search mode opens using the Medium-Speed Full-Page option, which is one of four ways 
of searching for an image:

� Full-Page
� Zoom 2X
� Zoom 3X

Note: The Fast-Search Option dropdown list is to the right of the Fast Search button.
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Option Description

Full-Page Refreshes faster than does Full Resolution mode. The image resolution is 
decimated by 50%, where every other pixel is displayed, skipping the next one.

Zoom 2X Displays the upper-left one-fourth of the full-resolution image. Refreshes 
faster than does Full Resolution mode.

Zoom 3X Displays the upper-left one-ninth of the full-resolution image. Refreshes faster 
than does Full Resolution mode.

Image Intensity
You can adjust the image intensity and contrast between the display of the light and dark areas 
of the microfiche by using three controls, which are, from left to right, the:

� Gray level scroll bar
� Film text radio buttons
� Exposure scroll bar
� Auto check box

Intensity Control Description

Gray level To set the amount of the gray portion of the image to convert to black 
so that it compresses more to increase the its transmission rate. This 
control has seven levels of gray�the right-most gives less grays (the 
fastest), and the left-most gives more grays (the slowest).

Film text To select the film type, which enables ImageMouse Plus to compress 
the data more efficiently for a faster data-transmission rate and an 
optimal image-refresh rate.

Black: For viewing film with dark text on a clear background.

White: For viewing film with clear text on a dark background.

Exposure To manually adjust the light intensity of the overall image.

Auto To automatically override the manual Exposure settings and readjust 
them to optimum values. After the image is adjusted, the Auto feature 
is automatically turned off.

Note: To make manual adjustments, alternately reset the Gray level and Exposure scroll bars 
until a good contrast occurs between the image of the microfiche�s data and its 
background.
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Image Focus
To focus the image:

� Ensure that the gray-level and exposure adjustments are completed.

� Slowly roll (in either direction) the Focus wheel, which is located at the front of the 
ImageMouse between its left and right buttons.

Note: If you continuously roll the Focus wheel in a particular direction, the lens continues to 
move up and down within a fixed range; therefore, rolling it in either direction performs 
the same action.

To more-easily adjust the focus of the image:

� Use Fast-Search mode, which gives a image-refresh rate that is faster than does the Full-
Resolution mode.

� Select the Zoom 3X search option, which displays the upper-left of the full-resolution image 
and enlarges the data three times larger than normal.

Reduction Ratio
To select one of the four reduction ratios, from the Reduction drop-down list, click either 24X, 
28X, 42X, or 48X.

Note: For optimal viewing, ensure that the reduction ratio of the ImageMouse Plus itself 
corresponds to that for the microfilm being viewed.

Image Size
To select one of two possible image-window sizes and orientations, click either the 8.5x11 
(portrait) or the 14x11 (landscape) radio button.

Note: The refresh rate of the 8.5 X 11 size is slightly faster.

Locating a Page
The method for locating a page (or frame) on a cut microfiche or microfilm is different from 
that for finding it on a roll of film.

Cut Microfiche or Microfilm
With the film-carrier handle, move the film carrier over the microfiche or microfilm until the 
selected page (or frame) appears on the PC�s monitor. See Figure 3-6 on page 3-7.
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Figure 3-6.  Hand on the Film-Carrier Handle

Figure 3-6.  Hand on the Film-Carrier Handle

Roll Film
Use the four buttons (from left to right�Fast Rewind, Rewind, Forward, Fast Forward) on the 
control panel to position the proper length of roll film beneath the top platen glass. See Figure 
3-7. For maximum film-winding speed when using the fast buttons, pull the film-carrier handle 
out all the way to lift the top platen glass off of the roll film.

Note: You can also use the two manual-rotation knobs to position the film.
Figure 3-7.  ImageMouse Plus Control Panel

Figure 3-7.  ImageMouse Plus Control Panel

� Use the film-carrier handle to fine-tune the placement of the selected image.
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Image Rotation
To rotate the displayed image 90 degrees clockwise or counter-clockwise, physically rotate the 
ImageMouse until the line marks on the ImageMouse retainer ring are aligned. See Figure 3-8.

Note: You can rotate the ImageMouse up to 100 degrees in either direction, which gives a 
10-degree leeway to help in obtaining an exact 90-degree alignment.

Figure 3-8.  ImageMouse Rotation

Figure 3-8.  ImageMouse Rotation

Full-Resolution Mode
After the proper image is found and displayed using the Fast-Search mode, click the Full-
Resolution button to switch to the Full-Resolution mode, which gives the image a higher 
resolution (and a slower image-refresh rate) for further processing, such as for viewing, 
zooming, panning, saving, and printing. See Figure 3-9 on page 3-9.
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Figure 3-9.  Full-Resolution Mode (with the image frozen)

Figure 3-9.  Full-Resolution Mode (with the image frozen)

Maximum View
To maximize the image-view area, from the Image menu, click Min/Max. To return the image 
to its normal area and have access to the image-manipulation controls, reclick Min/Max (this 
option is a toggle). See Figure 3-10 on page 3-10.
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Figure 3-10.  Maximum Image-View Area

Figure 3-10.  Maximum Image-View Area

Freeze and Live
To freeze the displayed image, click the Freeze radio button. To unfreeze the image (make it 
live), click the Live radio button, which enables you to move to another area of the microfiche 
and display it.

Note: To toggle between Freeze and Live�when in Freeze, press the Esc key for Live, or, 
when in Live, press the Spacebar for Freeze.

Zoom
When the image is frozen, the Zoom scroll bar appears beneath the Image Size radio buttons. 
Use it to vary the magnification of the frozen image from 1X to 4X in increments of 0.01X. You 
can pan the frozen image by dragging either the image or the vertical and horizontal scroll bars.
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Invert and Normal
To display the image with the gray scale inverted (the black and white areas exchange their 
shading values), click the Invert radio button. To redisplay the image in normal gray-scale 
shades, click the Normal radio button. To see the difference between a normal and an inverted 
image, compare the one in Figure 3-11 with the ones in Figure 3-9 on page 3-9 and Figure 3-10 
on page 3-10.

Note: You can save and print an inverted image.
Figure 3-11.  Inverted Image

Figure 3-11.  Inverted Image

Printing
To print a particular image:

1. In the Fast-Search mode, move the ImageMouse to find and display the image to print.

2. Either select the Auto check box or adjust the Gray level and Exposure scroll bars to 
obtain a good contrast.

3. If necessary, roll the Focus wheel to obtain a good focus.

4. Click the Full-Resolution button.

5. Click the Freeze radio button.

6. To print the full-resolution frozen image:

� Using the default printer settings:  From the Toolbar, click the Print,   , icon.
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� With changed printer settings:  From the File menu, click Print. The Print dialog box 
appears from which you can change the printer settings and then click OK. See 
Figure 3-12.

Figure 3-12.  Print Dialog Box

Figure 3-12.  Print Dialog Box

Saving an Image File
To save a particular image to your hard disk:

1. In the Fast-Search mode, move the ImageMouse to find and display the image to save.

2. Either select the Auto check box or adjust the Gray level and Exposure scroll bars to 
obtain a good contrast.

3. If necessary, roll the Focus wheel to obtain a good focus.

4. Click the Full-Resolution button.

5. Click the Freeze radio button.

6. To display the Save Image File dialog box, either:

� From the File menu, click Save, or

� From the Toolbar, click the Save icon, .

See Figure 3-13 on page 3-13.
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Figure 3-13.  Save Image File Dialog Box

Figure 3-13.  Save Image File Dialog Box

7. In the Save as type field, click the appropriate format from a dropdown list of four types, 
which are:

� JPEG 8-bit (*.jpg)
� BMP 8-bit (*.bmp)
� TIF 8-bit (*.tif)
� TIF G4 (*.tif)
� CMP 8-bit (*.cmp)

8. In the File name field, type name_of_the_file_to_save.

9. Click Save. The image saves to a graphics file on the hard disk in the folder that is 
specified in the Save in field.

Viewing an Image File
To view a particular image that is in a graphics file on your hard disk:

1. Click the Full-Resolution button.

2. Click the Freeze radio button.

3. To display the Open Image File dialog box, either:

� From the File menu, click Open, or

� From the Toolbar, click the Open icon, .

See Figure 3-14 on page 3-14.
3-13



DatagraphiX ImageMouse Plus User�s Guide
Figure 3-14.  Open Image File Dialog Box

Figure 3-14.  Open Image File Dialog Box

4. Ensure that the Files of type field indicates the type of file that you want to retrieve. For 
example, in Figure 3-14, if you want to view the icon.bmp image, ensure that 
bmp Files (*.bmp) shows in the Files of type field.

5. Either:

� Double-click on file_name_to_retrieve, or
� Click on file_name_to_retrieve and then click Open.

Note: When viewing an image from a retrieved graphics file, you can modify its visual 
attributes just like you can with an image from a microfiche that is viewed by the 
ImageMouse Plus. Then, you can resave it.

To close an image from a retrieved graphics file and redisplay an image from a microfiche that 
is viewed by the ImageMouse Plus, click the Fast-Search botton.
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Power-Saving Mode
After thirty minutes of ImageMouse Plus inactivity, the tablet lamp automatically switches off 
to both conserve energy and protect the loaded microfiche from overexposure. An ImageMouse 
warning dialog box appears. See Figure 3-15.
Figure 3-15.  ImageMouse Warning Dialog Box

Figure 3-15.  ImageMouse Warning Dialog Box

To resume normal ImageMouse Plus operation with the lamp at high intensity, click Retry. The 
ImageMouse warning dialog box vanishes.

To shut down ImageMouse Plus, click Cancel.
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Controls
You can control the ImageMouse Plus by using commands with the:

� Menu Bar
� Toolbar
� ImageMouse Plus Window
� ImageMouse Controls
� ImageMouse Plus Controls
� Hot Keys

Menu Bar
The Menu Bar contains three menus:

� File Menu
� Image Menu
� Help Menu

File Menu
The File menu contains four options:

Option Description

Open To retrieve a graphics file from the hard disk and display its image in the 
ImageMouse Plus window. See Figure 3-14 on page 3-14.

Save To save the image that is displayed in the ImageMouse Plus window to a 
graphics file on the hard disk. See Figure 3-13 on page 3-13.

Print To print the image that is displayed in the ImageMouse Plus window to either 
the default printer or the printer that you specify in the Print dialog box. See 
Figure 3-12 on page 3-12.

Exit To exit and shut down the ImageMouse Plus program.
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Image Menu
The Image menu contains two options:

Option Description

Min/Max Toggles the image-display area within the ImageMouse Plus window between 
its normal (minimized) area to its maximum area, which overlays the image-
manipulation controls. To regain access to these controls, again toggle 
Min/Max.

Copy Copies the image on the ImageMouse Plus window to the Windows clipboard 
from which you can paste it to other application programs.

Help Menu
The Help menu contains three options:

Option Description

Index Displays the ImageMouse Plus online help file. You can also access 
this option by pressing the F1 key.

Using Help Displays the Windows 98 instructions for using online help.

About ImageMouse Displays information about the development of the ImageMouse 
product.

Toolbar
The Toolbar contains six iconized buttons,   , 
which invoke the same options as do their counterparts from the Menu bar (from left to right):

� Open File (refer to the Open option under �File Menu� on page A-1)
� Save File (refer to the Save option under �File Menu� on page A-1)
� Copy Image (refer to the Copy option under �Image Menu�)
� Print Image (refer to the Print option under �File Menu� on page A-1)
� Display Full Screen (refer to the Min/Max option under �Image Menu�)
� Help (refer to the Index option under �Help Menu�)
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ImageMouse Plus Window
The ImageMouse Plus window, in addition to containing an image from the microfiche that is 
on the tablet, contains various tools for manipulating that image, such as buttons, scroll bars, 
check boxes, radio buttons, and dropdown lists:

Tool Description

Full Resoluton To display the image in full resolution (mutually exclusive with Fast Search).

Live Image To update the image from the ImageMouse Plus capture cycle (mutually 
exclusive with Freeze).

Freeze To freeze the image display for printing or saving (mutually exclusive with 
Live Image).

Zoom When the image is frozen in Full-Resolution mode, the Zoom scroll bar 
appears, which enables you to vary the magnification of the frozen image from 
1X to 4X in increments of 0.01X.

Reverse The image is flipped 180 degrees horizontally to accommodate images that are 
loaded in reverse.

Flip The image is flipped 180 degrees vertically to accommodate images that are 
loaded upside down.

Fast Search To search for data that is on the microfiche under the ImageMouse. It has a 
faster image-refresh rate and a lower image resolution than does Full-
Resolution mode, with which it is mutually exclusive.

Full Page Used in Fast-Search mode. Refreshes faster than does Full Resolution mode. 
The image resolution is decimated by 50%, where every other pixel is 
displayed, skipping the next one.

Zoom 2X To display the upper-left one-fourth of the full-resolution image. Refreshes 
faster than does Full Resolution mode.

Zoom 3X To display the upper-left one-ninth of the full-resolution image. Refreshes 
faster than does Full Resolution mode.

Gray level To set the amount of the gray portion of the image to convert to black so that 
it compresses more to increase the its transmission rate. This control has seven 
levels of gray�the right-most gives less grays (the fastest), and the left-most 
gives more grays (the slowest).

Exposure To manually adjust the light intensity of the image data. Dragging the scroll bar 
to the left decreases the light intensity.

Auto To automatically optimize both the background and exposure settings. When 
checked, it overrides both the Background and Exposure scroll-bar settings.

Image Size Each of these two radio buttons selects an image size and orientation:. 8.5 X 
11 (portrait) and 14 X 11 (landscape). The refresh rate of the 8.5 X 11 size is 
slightly faster.
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Reduction To select the reduction ratio of either 24X, 28X, 42X, or 48X, depending upon 
both the ImageMouse magnification setting and the reduction ratio of the 
microfiche.

ImageMouse Controls
The ImageMouse has three controls on its front side (from left to right):

Control Description

Left Button To toggle between Full-Resolution and Fast-Search mode.

Focusing Wheel To focus the ImageMouse lens on the microfiche.

Right Button To toggle between Live Image and Freeze settings.

ImageMouse Plus Controls
The ImageMouse Plus has four control buttons on its control panel. See Figure A-1.
Figure A-1.  ImageMouse Plus Control Panel

Figure A-1.  ImageMouse Plus Control Panel

These buttons move the film as described below, from left to right:

Button Description

Fast Rewind Backward (to the left) at medium speed
Rewind Backward (to the left) at slow speed
Forward Forward (to the right) at slow speed
Fast Forward Forward (to the right) at medium speed

Note: For high-speed film winding when using the fast buttons, pull the film-carrier handle 
all of the way out to lift the top platen glass off of the roll film.
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Hot Keys
When the ImageMouse Plus progam is active, some of the follwing keys perform ImageMouse-
Plus-specific commands:

Key Description

Spacebar To select Freeze, when in Full-Resolution mode
Esc To change to Live Image from Freeze
Enter To change to Full-Resolution mode from Fast-Search mode
Backspace To change to Fast-Search mode from Full-Resolution mode
Ctrl-N To open a new file
Ctrl-O To open an existing open file
Ctrl-P To print a file
Ctrl-S To save a file
Ctrl-C To edit/copy a file
Ctrl-X To edit/cut
Insert To edit/copy
Delete To edit/cut
F1 To invoke the Help file
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Appendix B

Frequently Asked Questions
How can I view an image that is in a file?

1. Start ImageMouse Plus.
2. From the File menu, click Open.
3. Browse to the folder that contains the image file.
4. Select the file and click Open.

Note: Any graphics program that supports the graphics format (JPG, BMP, TIFF, etc.) of 
the image to view can display it.

How long a cable can I use to connect my mouse?
The USB specification limits the length of a cable between full-speed devices to about four 
meters. Using the cable provided with ImageMouse Plus is best. Additional lengths may cause 
unstable images to display.

What other devices can I connect on the same USB hub?
Typically, any USB-compliant device can connect to the same USB hub, but do not run any 
other USB devices while running ImageMouse Plus. Insufficient resources allocated to the 
ImageMouse Plus may cause it to be unstable.

How can a quality image be obtained?
Clean all exposed glass regularly. Dust on the  glass is magnified along with the microfiche 
image.

How can a data file be associated with a program?
1. Open Windows� Exploring window.
2. From the View menu, click Folder Options.
3. Click the File Types tab. The Folder Options dialog box appears with the Registered file 

types list displayed. See Figure B-1 on page B-2.
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Figure B-1   Folder Options Dialog Box

Figure B-1.   Folder Options Dialog Box

4. In the Registered file types list, scroll to and select the file type to associate with a 
program. In this example, the file type is JPEG.

5. Click Edit. The Edit File Type dialog box appears. See Figure B-2 on page B-3.
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Figure B-2.  Edit File Type Dialog Box

Figure B-2.   Edit File Type Dialog Box

6. Click Edit. The Editing action for type: JPEG Image dialog box appears. See Figure B-3.
Figure B-3.  Editing Action For Type Dialog Box

Figure B-3.   Editing Action For Type Dialog Box

7. Click Browse. The Open With dialog box appears. See Figure B-4 on page B-4.
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Figure B-4.  Open With Dialog Box

Figure B-4.   Open With Dialog Box

8. Display the folder that lists the executable file of the program to associate the data-file 
type with.

9. Select the program�s executable file (*.exe) and click Open.

10. In the Editing action for type dialog box, click OK.

11. In the Edit File Type dialog box, click Close.

12. In the Folder Options dialog box, click Close. The association between the data-file type 
and the program is established. In this example, when clicking (or double-clicking) on the 
name of a JPEG file, ImageMouse Plus starts and loads that JPEG file.

How can I save exposure settings?
ImageMouse Plus retains the last exposure and background settings in memory. Currently, no 
support exists for active-user-saved exposure settings.

What do I check or do if the mouse freezes?
Usually, the cause is an unstable power supply. A full-system reset should correct this problem.

1. If possible, close ImageMouse Plus.

2. Shut down the PC.

3. Unplug the power cord from the ImageMouse unit.

4. Replug the power cord into the ImageMouse unit.

5. Restart the PC.

6. Restart ImageMouse Plus.

Note: If the problem persists, contact DatagraphiX Customer Service.
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How can I better focus my prints?
An unfocused image can be caused by:

� wrong display setting
� wrong background setting
� wrong exposure setting
� wrong focus adjustment

To resolve the problem, perform the following procedures in the order listed:

Display Setting

1. Right-click anywhere on the empty area of Windows Desktop.

2. In the pop-up menu, click Properties.

3. Click the Settings tab.

4. Ensure that High Color (16-bit) appears in the Colors field. If it does not, click 
the field�s down arrow and select High Color (16 bit).

5. Click Apply.

6. Click OK.

Exposure and Background Settings

1. On the ImageMouse window, check the Auto check box, which is located to the right of 
the Exposure slider. ImageMouse Plus automatically adjusts the exposure setting toward 
an optimum value.

2. When the automatic adjustments stablize, uncheck the Auto check box.

3. With the Exposure and Gray level sliders, manually fine tune the exposure and gray-level 
settings so that the best possible contrast and brightness settings occur.

Focus Adjustment

The focus should need adjustment only once for a particular type of fiche. If you change from 
one type of fiche to another, such as from originals to a thinner duplicate or a thicker jacket, you 
may need to manually adjust the focus with the wheel on the front of the mouse. To do so:

1. Select Fast Search mode and the Zoom 2X option. The image enlarges at about half 
resolution.

2. Rotate the focus wheel forward by a quarter turn and wait about one second to see the 
result.

3. Rotate another quarter turn and view the result, which should be a blurred image.

4. Continue to rotate the focus wheel in the same direction in quarter-turn increments until 
the image focuses to its maximum sharpness.

5. Select Full resolution mode to see the sharpest image possible.
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Note: You can endlessly rotate the focus wheel in either direction with the same result, which 
is to continuously cycle the focal length of the lens through its maximum and minimum 
distances.

How do I copy a microfiche image to another program?
1. Start ImageMouse Plus.

2. Position the ImageMouse over the selected area of the microfiche.

3. Adjust the focus and exposure.

4. Click Full Resolution.

5. Select Freeze.

6. From ImageMouse�s Edit menu, click Copy.

7. Start a second program, such as MS Word, Paint, or Excel.

8. In the second program�s display area, place the cursor at the location to paste the image.

9. From the second program�s Edit menu, click Paste. The image copies to the second 
program�s display area.

How do I insert (or attach) an image file into another program?
1. Start a program, such as MS Word, Paint, or Excel.

2. From the Insert menu, click File.

Note: In other programs, the Insert command is labeled Attach or some other name. To 
determine the proper commands, refer to the particular program�s documentation.

3. Browse to the folder that contains the image file.

4. Select the name of the image file to insert.

5. Click OK.

How do I work with an Image using MS Paint and Kodak Imaging
With Windows 98 Second Edition�s Accessories programs, such as Paint and Imaging, you can 
manipulate an image. In the Paint program, you can crop, flip, rotate, stretch, and skew an 
image. In the Kodak Imaging program, you can annotate an image.

Crop

1. Start the Paint program (a Windows Accessories program) and, if necessary, maximize its 
window for better viewing.

2. In the File menu, click Open.

3. Browse to the folder that contains the image file.

4. Select the image file.
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5. Click Open. The image appears in Paint�s display area.

6. Click the Select icon from the Tool palette to the left of the display area. The mouse 
pointer changes into cross hairs.

7. Drag the mouse on the image to select a rectangular area, which becomes bordered by 
dashed lines. See Figure B-5.

Figure B-5.  Cropping in Paint 

Figure B-5.   Cropping in Paint

8. From the Edit menu, click Copy To. See Figure B-6.
Figure B-6.  Copying the Cropped Image

Figure B-6.   Copying the Cropped Image
B-7



DatagraphiX ImageMouse Plus User�s Guide
9. In the Copy To dialog box, type a file name into the File name field.

10. Click Save.

Note:  This method only saves the image in BMP format.

Flip/Rotate, Stretch/Skew

1. Start the Paint program (a Windows Accessories program) and, if necessary, maximize its 
window for better viewing.

2. In the File menu, click Open.

3. Browse to the folder that contains the image file.

4. Select the image file.

5. Click Open. The image appears in Paint�s display area.

6. From the Image menu, click either Flip/Rotate or Stretch/Skew. See Figure B-7.
Figure B-7.  Flip, Rotate, Stretch, and Skew the Image

Figure B-7.   Flip, Rotate, Stretch, and Skew the Image

7. In either the Flip and Rotate or Stretch and Skew dialog box, select modifications to the 
image and click OK.

8. From the File menu, save the new image as required.

Annotation

1. Start the Kodak Imaging program (a Windows Accessories program) and, if necessary, 
maximize its window for better viewing.

2. In the File menu, click Open.

3. Browse to the folder that contains the image file.
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4. Select the image file.

5. Click Open. The image appears in Imaging�s display area.

6. From the Annotation menu, click the selected annotation and enter its options. See Figure 
B-8.

Note: For descriptions of the options, refer to the program�s online-help feature.
Figure B-8.  Annotation Menu

Figure B-8.   Annotation Menu

7. From the File menu, save the new image as required.

How do I enable the USB port in the BIOS?
You must install ImageMouse Plus on a PC that possesses a:

� Windows 98 Second Edition operating system
� BIOS that supports a USB port
� USB port. See Figure B-9.
Figure B-9.  Partial View of the Back of a PC with USB Ports

Figure B-9.   Partial View of the Back of a PC with USB Ports

Typical USB port
receptacles
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For ImageMouse Plus to install and operate, the USB port must be enabled. Sometimes, this 
must be done manually. Usually you can enable the USB port from the setup menu of the PC�s 
BIOS. To do so:

1. At the beginning of the PC start process, access the BIOS setup menu by pressing  F1 
when prompted.

Note: Sometimes, in other BIOS versions, you need to press either Esc, Delete, or F2 to 
access the BIOS menu.

2. Select the Peripherals page, which should contain the USB settings.

3. Change the setting to enable the USB port.

4. Save the modified settings.

5. Exit the BIOS Setup.

Note: If your PC contains a USB port, but the BIOS does not support it, contact your PC 
manufacturer for a possible BIOS upgrade or obtain another PC that has a BIOS that 
supports its USB port.

How do I resolve conflicting IRQs?
Usually, the USB host controller can share IRQs with other devices. In some cases, if the USB 
host controller uses the same IRQs with other devices, ImageMouse Plus might not work 
properly. For example, ImageMouse Plus might freeze or not be detected by Windows 98. If 
this happens, you can manually reserve an IRQ so that the USB host controller possesses its 
own IRQ. To do so:

1. On Windows Desktop, right-click the My Computer icon.

2. From the popup menu, click Properties. The System Properties dialog box appears.

3. Click the Device Manager tab. See Figure B-10 on page B-11.
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Figure B-10.  System Properties Dialog Box

Figure B-10.   System Properties Dialog Box

4. Double-click the Computer icon located at the top of the display area. The Computer 
Properties dialog box�s View Resources page appears. See Figure B-11.

Figure B-11.  Computer Properties Dialog Box, View Resources Page

Figure B-11.  Computer Properties Dialog Box, View Resources Page

5. Ensure that the Interupt request (IRQ) radio button is selected.

6. Scroll down the list of IRQs to view the IRQ number and the name of the USB Host 
Controller.
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Note: In this example, they are, respectively, 10 and VIA tech 3038 PCI to 
USB Universal Host Controller. See Figure B-11 on page B-11.

7. Click the Reserve Resources tab. See Figure B-12.
Figure B-12.  Computer Properties Dialog Box, Reserve Resources Page

Figure B-12.  Computer Properties Dialog Box, Reserve Resources Page

8. Click Add. The Edit Resource Setting dialog box appears. See Figure B-13.
Figure B-13.  Edit Resource Setting Dialog Box

Figure B-13.   Edit Resource Setting Dialog Box

9. Type the IRQ number that the USB host controller is currently using. In this example, 
it is 10.

10. Click OK.

11. Click OK on the Resource Conflict Warning dialog box and then on the Computer 
Properties dialog box.
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12. In the System Properties dialog box, click the + sign in front of the Universal 
Serial Bus controller line.

13. Click (highlight) the ... USB Universal Serial Bus Host Controller 
line.

14. Click Remove. The Confirm Device Removal message box appears.

15. Click OK.

16. Shutdown and restart the system for the new setting to take affect. All of the Universal 
Serial Bus Controller items should be detected, and the host controller assigned a new IRQ 
number.

17. Operate ImageMouse Plus to ensure that it works properly.

18. Repeat Steps 1 through 6, but instead of adding a reserved IRQ, the IRQ that was reserved 
will be high-lighted and removed.

19. Shutdown and restart the system.
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Troubleshooting
For ImageMouse Plus to work properly, the USB host controller, USB root hub, and 
ImageMouse Plus hardware must be properly installed and configured. To verify this, check to 
ensure that these items are properly detected. To do so:

1. On Windows Desktop, right-click the My Computer icon.

2. From the popup menu, click Properties. The System Properties dialog box appears.

3. Click the Device Manager tab.

4. Click the plus sign (+) in front of the Universal Serial Bus controllers line. Beneath should 
appear at least three lines�DatagraphiX (ImageMouse) USB Device, USB Root Hub, and 
VIA Tech 3038 PCI to USB Universal Host Controller. See Figure C-1. (Your PC�s 
motherboard may have a different chipset in which case the last line would be different.)

Figure C-1.  System Properties Dialog Box

Figure C-1.   System Properties Dialog Box
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With your computer, if these three lines are not present, you must troubleshoot, as follows:

The Device Manager page lists no USB devices

� Refer to your PC�s documentation or contact the PC manufacturer to ensure that your PC 
supports a USB port.

� Your computer's USB port might not be enabled. The USB port must be enabled and 
configured for ImageMouse Plus to operate.

� To install ImageMouse Plus, your PC must have Microsoft Windows 98 Second Edition 
installed. To determine the version of Windows 98 that you are using:

� On Windows Desktop, right-click the My Computer icon.

� From the popup menu, click Properties.

� In the System Properties dialog box�s General page, ensure that Microsoft Windows 
98 Second Edition 4.10.2222.A appears. Otherwise, ImageMouse Plus might not work 
properly.

The Device Manager page lists the USB Host Controller but no USB Root Hub

� On Windows Desktop, right-click the My Computer icon.

� From the popup menu, click Properties.

� In the System Properties dialog box�s Device Manager page, ensure that the minus sign (-) 
is in front of the Universal Serial Bus controllers line. See Figure C-1 on page C-1.

� Select the �USB Host Controller line.

� Click Remove.

� Click Refresh. Windows 98 redetects the hardware and should find both the Host 
Controller and the Root Hub. Follow the prompts in the hardware wizard.

Note: If a prompt asks you to insert the Windows 98 Second Edition installation CD into 
the CD drive, do so and continue to execute the prompt�s instructions. A system 
restart is required for the new setting to take effect.

The Device Manager page detects no ImageMouse, but, under the Other Device 
line, an unknown USB Device line with a question mark exists

� On Windows Desktop, right-click the My Computer icon.

� From the popup menu, click Properties.

� In the System Properties dialog box�s Device Manager page, ensure that the minus sign (-) 
is in front of the Other Devices line.

� Click the unknown USB Device to highlight it.

� Click Remove.
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� Click Refresh. Windows redetects the hardware.

� Follow the hardware-wizard prompts.

Note: If prompted to insert your Windows installation CD, do not do so. Instead, click 
OK and browse to file:

C:\program files\Datagraphix ImageMouse\imagemouse\anacomp.inf

The Device Manager page detects the USB Root Hub and USB Host controller 
but not the ImageMouse

Possible causes are that the:

� USB port is defective or
� the ImageMouse Plus unit has no power.

Possible solutions are:

� Press the lamp-test button at the right-rear of the ImageMouse Plus unit. If the lamp does 
not illuminate, check that its power cord is properly connected at each end.

� Install a different USB device on your PC. If it works, possibly the ImageMouse Plus 
hardware is defective. Contact DatagraphiX Customer Service. If it does not work, possibly 
the USB cable or port is bad. Contact the PC manufacturer.

� Install the ImageMouse Plus on a different computer that supports USB devices. If it works, 
possibly the USB port on the original PC is bad. Contact the PC manufacturer. If the 
ImageMouse Plus does not work, it may be defective. Contact DatagraphiX Customer 
Service.

The USB connection locks up while operating ImageMouse Plus

Some USB connection lock-ups are related to BIOS or Wondows 98. Check with your PC 
manufacturer for the latest BIOS updates, or access the Microsoft Web site for updates that 
pertain to the USB port.

The Device Manager page detects the USB Host Controller and the USB Root 
Hub, but ImageMouse appears under Other Devices as USB Device

In this case the autoinstall wizard did not work (see Figure C-2 on page C-4). You need to 
configure the ImageMouse Plus hardware manually. To do so:

1. Ensure that the ImageMouse Plus software is installed.

2. On Windows Desktop, right-click the My Computer icon.

3. From the popup menu, click System Properties.

4. In the System Properties dialog box�s Device Manager page, double-click the ? USB 
Devices line (see Figure C-2 on page C-4). The USB Device Properties dialog box 
appears. See Figure C-3 on page C-4.
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Figure C-2.  System Properties Dialog Box Device Manager (Other Devices)

Figure C-2.   System Properties Dialog Box Device Manager (Other Devices)

Figure C-3.  USB Device Properties Dialog Box

Figure C-3.   USB Device Properties Dialog Box
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5. Click Reinstall Driver to display Update Device Drive Wizard box one. See Figure C-4.
Figure C-4.  Update Device Driver Wizard Box (Driver Search)

Figure C-4.   Update Device Driver Wizard Box (Driver Search)

6. Click Next.

7. On the next wizard box, select Display a list of all driver in a specific location � radio 
button. See Figure C-5.

Figure C-5.  Update Device Driver Wizard Box (Display Drivers)

Figure C-5.   Update Device Driver Wizard Box (Display Drivers)

8. Click Next.

9. On the next wizard box, click Have Disk. See Figure C-6 on page C-6.
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Figure C-6.  Update Device Driver Wizard Box (Find Driver)

Figure C-6.   Update Device Driver Wizard Box (Find Driver)

10.  From the Install From Disk dialog box, click Browse. See Figure C-7.
Figure C-7.  Install From Disk Dialog Box

Figure C-7.   Install From Disk Dialog Box

11.  Browse to the following file:

c:\Program Files\DatagraphiX\ImageMouse\anacomp.inf

See Figure C-8 on page C-7.
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Figure C-8.  Open Dialog Box

Figure C-8.   Open Dialog Box

12. With the File name field containing anacomp.inf, click OK.

13. When the Install From Disk dialog box reappears with the Copy manufacturer�s files 
from: field containing:

c:\Program Files\DatagraphiX ImageMouse\ImageMouse\anacomp.inf

click OK.

14.  On the next wizard box, in the Models list area, click (highlight) DatagraphiX USB 
Device. See Figure C-9.

Figure C-9.  Update Device Driver Wizard Box (Select Driver)

Figure C-9.   Update Device Driver Wizard Box (Select Driver)
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15. Click Next.

16. When the Device Driver Update Warning dialog box appears, click Yes.

17. On the next wizard box, click Next.

Windows 98 begins to install the DatagraphiX USB Device (ImageMouse) driver.

Note: If prompted to insert the Windows 98 installation CD into the CD drive, do not do 
so. Instead, browse to the file:

 “c:\Program Files\DatagraphiX ImageMouse\ImageMouse\anacomp.inf

18. After Windows finishes installing the ImageMouse driver, click Finish on the last wizard 
box.

19. When the USB Device Properties dialog box reappears, click OK.

20. When the System Properties dialog box reappears, the DatagraphiX USB Device line 
should be listed underneath the Universal Serial Bus controllers line as shown on Figure 
C-1 on page C-1. Also, the ? USB Device line underneath the Other Device line should 
disappear.

Note: After the ImageMouse Plus software is installed and when Windows 98 connects the 
ImageMouse Plus, sometimes it prompts to insert the Windows 98 installation CD into 
the CD drive. If this occurs, do not insert the Window 98 CD into the CD drive. Instead, 
browse to the:

c:\Program Files\DatagraphiX ImageMouse\ImageMouse\anacomp.inf

file and click OK to install the ImageMouse driver.

Future Enhancements
DatagraphiX is working on the following ImageMouse Plus enhancements:

� More image-manipulation tools, for example�built-in de-skew, crop, and rotate tools.

� Roll-film support for a variety of roll-film formats, for example�3M, Kodak, ANSI

� Windows 2000 support

� Windows NT support

� Support for more frame sizes

� Faster refresh rate
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Comment Form
If you have any comments regarding the DatagraphiX ImageMouse Plus User�s Guide  (including its 
content, organization and format), use this form to communicate them directly to Anacomp. If you have 
received any revision pages to update this book, please identify them. Your comments will be reviewed 
and appropriate action taken, as necessary. Note that Anacomp may use or distribute the information 
you supply without incurring any obligation to you.
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